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Alone on Mars, looking for a seismic zone! 

 

 

 

Introduction: 

 

After a year of analysing SEIS data, the InSight mission’s scientific teams have detected 

numerous marsquakes. The strongest events were located in a particular region of Mars. Thus, 

for the first time in the history of modern seismology, an active seismic zone has clearly been 

highlighted on another planet. 

 

Goals : 

 

This workshop proposes to find the location of the epicentre of a "marsquake" detected by SEIS 

during July 26, 2019, i.e. on the 235th sol of the mission. 

The course of this workshop allows you to delve into the work routine of researchers when 

receiving new data: 

 o Data filtering 

 o Calculation of the spectrogram 

 o Identification of seismic waves (P and S) 

 o Estimation of an epicentral distance 

 o Location of the seismic focus 

 

Hardware, software and data: 

- seismograms of the marsquake, in sac format, that occurred on sol 235 (1); 

- the software © SeisGram2K80_ECOLE and its tutorial (SG2K80); 

- an accelerometer from the Maison des Enseignants de Provence (MEP); 

- the software © RISSC (Record Interface for Sensors at School); 

- appendices to deepen certain concepts 

 

(1)  InSight Mars SEIS Data Service. (2019). SEIS raw data, Insight Mission. IPGP, JPL, CNES, 

ETHZ, ICL, MPS, ISAE-Supaero, LPG, MFSC; 

https://doi.org/10.18715/SEIS.INSIGHT.XB_2016 

 

https://doi.org/10.18715/SEIS.INSIGHT.XB_2016
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Procedure: 

 

Step 1 - Identification of a P wave and an S wave, and estimation of the epicentral distance 

 

  Real data: seismograms of marsquake of sol 235 

 

  Work: - identify its waves and note their respective arrival times; 

                 - determine the epicentral distance. 

 

 

 

Step 2 - Observe the variation in amplitude of the waves recorded by a sensor according 

to its orientation. 

 

  Experiment: recording passages of waves generated in different places around an 

accelerometer 

 

  Work: analyse each recording to highlight the link between amplitude of the 

recordings, direction of wave propagation, and position of the sensor. 

 

 

 

 

Step 3 - Location of the epicentre from the analysis of the P wave on the three components 

of SEIS 

 

  Work: analyse the polarity of the P wave on the three components to determine the 

position of the epicentre. 
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Step 1 - Identification of a P wave and an S wave, and estimation of the epicentral distance 

 

- Open the SG2K80 software : 

    > change the language  

[ Utilitaires > Langue… > Anglais] 

    > select the seismograms from the “sol235” directory  

[File> Select File> select the 3 available seismograms] 

 

 

Appendix A provides a description of the principle of filtering and calculating the spectrogram. 

 

Your first objective is to identify seismic waves in these 3 seismograms. Which procedure do 

you prefer to use: 

 o   Filter the signal? Go to the “Filtering” section below; 

 o Translate the signal into a spectrogram? Then go to the "Calculation of the 

spectrogram" section. 

 

filtering 

 

- Using the [Filter] tool of SG2K80, test different combinations of bandpass filtering in 

order to highlight an event resembling a passage of seismic waves. 

 

PLEASE NOTE: each time you apply a filter, you must work on the complete unfiltered signal. 

It is imperative to restore the content of the seismogram between each filtering 

[ File > Reset  Active]. 

 

 

- Propose an interval of frequency values to facilitate the visualisation of a passage of 

seismic waves: 

 

 Minimum frequency (Hz): ………… Maximum frequency (Hz): ………… 
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Calculation of the spectrogram 

 

- Using the [Spectrogram] tool of SG2K80, display the spectrogram of the Z component. 

- Identify the arrival of P waves and S waves. 

- Determine the values of a bandwidth filtering to facilitate the reading of seismic waves 

in seismogram: 

 

 Minimum frequency (Hz): ………… Maximum frequency (Hz): ………… 

 

Discussion around these two procedures 

 

Your second goal now is to estimate the distance to the epicentre from the arrival times. 

 

- From the [Pointer…] tool of SG2K80, point the arrival times of the first P wave and the 

first S wave. 

- Calculate the delay between the two arrival times: 

  TS - TP = …… .. seconds 

- activate the hodochron tool [ Display active seismogram in travel time graph for distant 

events ]   

- determine the theoretical distance to the epicentre corresponding to this delay. 

  Epicentral distance = ……… .. degrees 

 

BE CAREFUL: for this Martian ‘earthquake’, you must absolutely use the planet model for 

Mars [Utilities> Planet…> tick the Mars box] 

 

 

 The epicentre is on a circle centred on SEIS, and of radius 

equal to the calculated distance (diagram opposite) 

  You must now define its exact position! 
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Step 2 - Observe the relationship between the amplitude value of the waves detected by a 

fixed accelerometer, and their direction of propagation. 

 

Let's leave Mars for a while to come back to the classroom. We are going to carry out a small 

experiment to highlight the relationship between: 

 - the orientation of a three-component accelerometer on a table, 

 - the direction of wave propagation, 

 - the measured amplitude of these waves. 

The detected signals will be displayed using the RISSC educational interface, developed by 

David Ambrois (CNRS Study Engineer). This step will be done in two stages, according to the 

following protocols. 

 

 

  Experimental protocol n ° 1 

- Position the accelerometer on the support provided. Make sure that the support adheres well 

to the table, and that the sensor adheres well to the support (patafix/blu tack). 

- connect the USB file of the sensor to the computer 

- launch the RISSC interface, and open the "Accelerometer" tab (In French : « Accéléromètre ») 

- start recording [Start] 

- successively apply a shock to each of the side faces of the support 

- stop recording [Stop] 

- centre the signals on the baseline of the graphs [check the Demean box] 

- put the recordings on the same vertical scale [check the Same Scale box] 

 

- Locate the passage of the waves of each shock. 

- What relationship can we highlight between the direction of the shock applied, and the 

amplitude of the waves on the Y and X components? 
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 Experimental protocol n ° 2 

 

- Make a new recording, applying only one shock to one of the side edges of the support. 

- From the relationship deduced previously, try to position the sensor on the support to 

maximize the amplitude of the waves on the X component, and to minimize it on the Y 

component. 

- What parameter can be highlighted by analysing the amplitude of the waves on each 

horizontal component of a three-component sensor? 

 

 

 

 

Schemes of the two experimental protocols. 

 

 

 

Appendix B provides a more detailed description of the first movement of the ground when a 

seismic wave (P) arrives. Now it’s time to go back to Mars. 
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Step 3 - Determination of the position of the epicentre from the analysis of the P wave on 

the three components of the seismometer 

 

Appendix C provides a description of the determination of the first movement of the ground 

during an earthquake, from the reading of the first P wave. 

Martian data remains quite difficult to analyse. To simplify the reading of the signals, we will 

work on a zoom around the arrival of the P wave on each component. This zoom is then filtered 

to keep only waves that have frequencies between 0.1 Hz and 4.0 Hz. 

We will analyse the horizontal component of the first movement first, then its vertical 

component in a second step. 

 

- Restore signals [ File > Reset Active ] 

- Zoom in on the signals, between 12:08 a.m. and 12:38 a.m. 

- Apply band pass filtering between 0.1 Hz and 4.0 Hz. 

- Locate the arrival of the first P wave on the Z component. 

- Observe the first arch of the P wave on the two horizontal components. 

- What immediate remark can we make? 

- Activate the horizontal components rotation tool [ Tools > Tourner ] 

- What do we observe when we perform a rotation of + 90 °? 

- On the following diagram, draw an arrow describing the horizontal component of the 

vector of the first movement associated with the arrival of the P wave: 
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We now know the horizontal component of the first movement. Let us now work in the vertical 

plane, perpendicular to the horizontal plane and passing through the direction of the vector 

previously determined (Fig. 1). 

 

 

Figure 1. Vertical plane passing through the direction determined from the polarity of the P 

wave on the horizontal components. The yellow vector characterises the horizontal component 

of the first movement of the marsquake of sol 235. Blue dotted line: direction of the horizontal 

component of the first movement. 

 

 Figure 2 offers two examples of breaks with generated waves that were recorded by the same 

station. Appendix C provides examples to help you understand the framework of this exercise. 

 

- In Figure 2, draw the simplified polarities of the first P wave according to the two 

proposed cases. 

- What is for each case the direction of the horizontal component of the movement?  

- Is the meaning of this component sufficient to determine the position of the epicentre? 
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Figure 2. Schematic west / east sections passing through a seismic station, detecting the 

passage of seismic waves generated by a seismic rupture. (a) Fault located in the East. (b) 

Fault located to the West. (c) Draw in a simplified way the polarity expected for each 

component, according to the two cases (a) and (b). 
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In seismology, there are two terms related to the direction of the first movement (Fig. 3): 

- the azimuth, which is the angle between the direction of the geographic north and the direction 

of the direction of the horizontal component of the first movement (positive angle towards the 

East), 

- the back-azimuth, which provides information on the position of the epicentre along the 

direction materialised by the azimuth: 

 o if the polarity of the P wave on the vertical component is positive, the value of the 

back-azimuth is equal to the value of the azimuth plus the value of Pi (or + 180 °> to 

the East) 

 o if the polarity of the P wave on the vertical component is negative, the value of the 

back-azimuth is equal to the value of the azimuth. 

 

Figure 3. This figure is from the publication (doi: 10.2312 / GFZ. NMSOP-2_IS_11.1) by Jens 

Havskov (University of Bergen), Peter Bormann (German Research Centre for Geosciences), 

and Johannes Schweitzer (NORSAR). It describes the determination of the azimuth and back-

azimuth from a simplified example of the recording of the P wave on three components of the 

same sensor. 

 

 

- Determine the value of the back-azimuth, the angle giving the direction of the epicentre: 

back-azimuth =: ……………… .. 
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One distance, one direction: but where is it on Mars? 

 

The Marsview educational interface (developed by Philippe Cosentino). 

Specially developed for the French educational component of the InSight mission, the 

Marsview interface allows simple and practical visualisation of the results obtained. 

 

 

Connect to the interface via the following URL: 

  http://philippe.cosentino.free.fr/productions/marsview/ 

- In the left column, check the [circle] box (in French: “cercle”) in the [Tool] space (in French 

: “Outil”) 

- Locate the location of the estimated epicentre from the calculated epicentral distance, 

and the back-azimuth: 

 - latitude: …………………  - longitude: ………………… 

- Place this location on the map below: 

 

 

 

 

 

 

 

The results of the Science Team 

http://philippe.cosentino.free.fr/productions/marsview/
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The epicentre was located about 25.9 ° from the seismometer, or about 1535 km. The 

corresponding azimuth has been estimated at approximately 77 °. 

 

Congratulations! You have in turn identified this seismically active Martian area: Cerberus 

Fossae. This zone corresponds to grabens indicating an extensive context during their 

formation. Previous work had looked at quantifying the seismic activity in this area, using 

HiRISE satellite images (Taylor et al., 2013, doi: 10.1002 / 2013JE004469). This area was 

already mentioned as a seismic source probably useful for the InSight mission. It is now 

confirmed. 

You are now ready to analyse the future data from the movement of Martian soil, which will 

be made available gradually on the InSight Education component website: 

    https://insight.oca.eu/fr/accueil-insight 

 

 

It's your turn to play now! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://insight.oca.eu/fr/accueil-insight
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APPENDIX A: frequency, spectral analysis and spectrograms 

 

Amplitude, period and frequency 

 

Periodic signals are repeated over a time interval called the period (T). They are characterized 

by their amplitude (A) and frequency (f). 

 

Figure 1 : Here, the signal has a period of 2 seconds (i.e. a frequency of 0.5 Hz), and an amplitude of 5 

expressed here in arbitrary units. 

 

The amplitude (A) corresponds to the maximum deviation of the variable from its median value. 

The amplitude reflects the "energy" of the wave motion.  The frequency is expressed in Hertz, 

it is equal to the inverse of the period (T) measured in seconds. 𝑓 =  
1

𝑇
 

 

Fourier analysis 

 

Complex signals could be decomposed into a sum of sinusoidal functions. Joseph Fourier, a 

French mathematician and physicist of the 18th century, was the first to propose the 

mathematical tools for this decomposition. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                 

 

 

 

 

 

Figure 2: a periodic signal (green line) is 

decomposed into 2 sinusoidal signals. The 

amplitude of the 2 signals is represented on the 

frequency spectrum as a function of their 

frequency. 

. 
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The signal (Fig.2, green line) has been decomposed into 2 sinusoidal functions, each 

characterized by a frequency and an amplitude. The frequency content of the signal can then be 

represented on a diagram: the frequency spectrum. 

 

To determine the different spectral components of a seismic signal, the Fourier transform is 

used. The frequency spectrum of the signal at time t then takes the form of a continuous curve 

(Figure 3). 

 

 

 

 

 

 

 

 

 

 

 
Figure 3 : An accoustic signal (left) and its Fourier transform which is its frequency spectrum (source: 

BTS SNIR course, the pedagogical web) 

 

Filtering 

To remove (or more exactly reduce the content) specific frequencies in the signal, a filtering 

procedure is used. Its aim is to modify the amplitude and the phase of frequencies. For each of 

them, a correction factor for the amplitude value is applied, which allows to remove (by 

reducing the amplitude value to zero) chosen frequencies. More precisely, a numerical factor 

carries out successive mathematical procedures, which modify the spectral content of the input 

signal: unwanted frequencies (spectral components) are attenuated, or removed. 

 

Spectrogram 

The spectral content changed in frequency and in intensity over time. These variations could be 

highlighted from Fourier transform within a sliding time windows. The obstained spectrums 

are concatened. The result is a 3D diagram which represents the evolution of the frequency 

spectrum over time: the spectrogram (Figure 4).   

Figure 4 : This 3D spectrogram is made up of more than 20 FFT analyses performed one after the other 

(Source: NPRI). 
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The 3D digram is interesting but difficult to use. A 2D view is preferred, in which amplitudes 

of all frequencies are represented with a scale color (Figure 5). 

Figure 5 : Seismogram (bottom) and corresponding spectrogram (top) obtained with the “spectrogram 

tool” of the software SeisGram2K. The signal displayed comes from the “InSight Blind Test challenge” 

organized by the InSight Science Team. The colours indicate the frequency content amplitude, from low 

(light blue) to high (yellow). 

 

In Figure 5, the spectrogram shows that Rayleigh waves (Lr1, Lr2 et Lr3 ) have a frequency 

content around 0.1 Hz, which correspond to the low frequency domain in seismology. The 

shape of the colored points in red dashed rectangles is due to one of their characteristic: a 

velocity, which is depending of their frequency.  The spectrogram allows to analysis variations 

of the frequency content over time, and to detect different kind of events. In seismology, this 

tool is currently used to detect arrival of seismic waves. 

 

 

Bonus section:  Fourier transform 

 

In 1807, Joseph FOURIER, French mathematician, claimed that it was possible, under specific 

conditions, to decompose a periodic function into an infinite sum of sinusoidal signals.  

Let the periodic signal x(t) , with a period
0
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The objective of the Fourier transform is to find a new representation of the signal other than 

the amplitude/time space that helps us to understand the physical content of the signal.  

 

 

Lr1 

Lr3 
Lr2 
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APPENDIX B 

 

The first movement of the ground when a P wave arrives 

 

When the ground starts to shake, it is subject to the influence of the first P wave to arrive. This 

very first movement can be defined by a vector having three components in space: two 

horizontal (AN and AE) and a vertical (AZ). These three components can be identified with the 

records provided by the seismological stations having three sensors (two horizontal, North / 

South and East / West directions, and a vertical sensor). 

 

 
 

Simplified diagram of the arrival of a seismic line (red dotted arrow) at the surface, and of the 

vector in three dimensions (thick red arrow) characterising the first movement of the 

corresponding ground, translated by a vector. AE: decomposition of the vector in the East 

direction. AN: decomposition of the vector in the North direction. AZ: decomposition of the 

vector in the vertical direction. Azimuth: angle between the direction of geographic north and 

the projection of the vector in the horizontal plane. 

 

 

By analysing the shape of the arrival of the P wave on the horizontal components, it is possible 

to determine the angle of the direction of this first movement. This angle, called azimuth, will 

be taken into account to define the exact position of the epicentre. 

Each component provides information on the direction of the first movement of the ground 

when the first P wave arrives. By convention, if the first arch corresponding to the P wave 

points towards the top of the plot, this means that the movement is positive in the direction of 

the component. Figure 4 illustrates this point. 

 

 
Schematic representation of the arrival of the same P wave on three components. The polarity 

of the first arch gives the direction of movement according to the direction considered. 

 

On these three components having recorded the same P wave, according to the orientation of 

the arches the movement associated with this first P wave is both north, west, and down. 
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APPENDIX C 

 

Analysis of the polarity of the P wave in the three directions of the seismometer 

 

Seismology likes to ask enigmas to its followers. To think that the direction of the first 

movement of the ground in the horizontal plane makes it possible to find the position of the 

epicentre is a little quick. Let’s see why. The Figure below shows schematic sections of 

geological sections, in a west / east direction, passing through any two seismological stations. 

Be careful, an earthquake is preparing. Indeed, somewhere deep in the East, there is a fault 

ready to break. During the rupture, the state of stress on both sides of the fault is not the same 

in all directions. There are areas subject to compression (red areas), and areas subject to 

expansion (white areas). This very simplified approach to reality still allows to highlight two 

types of P waves: 

 

 - P waves generated in the compression zones: the first movement of the particles is 

done by "pushing" the following ones; 

 - P waves generated in the zones in dilation: the first movement of the particles is 

done by "pulling" the following ones. 

 

This characteristic is found at the polarity of the first P wave in the vertical direction: positive 

(by convention upwards) for a wave generated in a compression zone, negative (downwards) 

for a wave generated in a zone in compression. The wave thus arrives with a precise polarity 

according to the vertical plane at the measurement point. But it also has a polarity in the 

horizontal plane at the point of measurement. The very simplified seismograms in the following 

figure show these polarities from the first P wave to the two seismological stations. We see that 

the same earthquake can induce two types of waves with different characteristics. 

 

 
 

Simplified diagram relating a seismic rupture and polarity of the P wave. (A) Schematic West 

/ East section passing through two seismological stations A and B, illustrating a seismic rupture 

in preparation. The degraded coloration on both sides of the fault indicates the stress 

undergone by the surrounding rocks: red: compression; white: dilation. (b) Seismic rupture 

and evolution of the wave front (red circles) and directions of seismic lines (c) Polarity of the 

first P wave recorded on each component of the two stations. 
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APPENDIX D 

 

Small introduction to the focus mechanism, and to the radiation of P waves 

 

The following figure presents two rocky blocks subjected to an extensive context (a), which 

causes an earthquake, that is to say a brutal sliding instability, the rupture, along a mechanical 

discontinuity, the fault (b). The fault plane that separates the two rocky compartments has a 

very precise orientation in space, which will have an influence on the P waves generated. 

Seismic rupture can be described as a shearing phenomenon, causing a relative movement of 

the two dislocated blocks. A simple approach is to explain this movement as the result of the 

application of a couple of forces (c), of the same standard but of opposite direction. This 

approach authorising a rotation of the fault plane by the application of these forces, and such a 

rotation not being possible underground (confined medium) it is necessary to add to this model 

a second pair of forces, identical to the first but which it is orthogonal. This model, known as 

double-couple (d), is used to describe a shearing rupture. 

This means that this model takes into account a second virtual plane, called the auxiliary plane, 

orthogonal to the fault plane. 

These two planes define in space four zones at the level of which the material will react 

differently near the rupture: two zones are subjected to compression (d), two zones are subjected 

to expansion (d). 

 

The particles set in motion will have a type of pulse which varies depending on the area where 

it is initiated: 

 - an impulse like a push in the areas under compression, 

 - an impulse like a traction in dilated areas. 

  

This very first movement will be found during the recording of the first P wave at a 

seismological station (e). If the P wave was generated in a compression zone, the polarity in the 

vertical plane will be positive upwards, or negative if the P wave has been generated in a dilation 

zone. The same break, but variable characteristics. 
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(a) Blue arrows: direction of the traction exerted on both sides of a rock volume, characterising 

an extensive context. (b) Red arrows: direction of movement of each boulder during the rupture 

on either side of the fault plane (shaded area). (c) Physical diagram of a shearing rupture 

around the fault plane (shaded surface). (d) The double couple model. “+” Red: areas in 

compression compared to the play of the rupture. “-” black: dilated areas. (e) Simplified 

diagram of this deep rupture of a planet, having four seismological stations on its surface. 

Black arrows: internal paths of seismic spokes. Red ellipsoids: areas in compression around 

the rupture. White ellipsoids: dilated areas around the rupture. Z> 0: positive polarity, or 

upwards, of the first movement. Z <0: negative polarity, or downwards, of the first movement. 

 


